
A
In this appendix, we’ll show how you can install tools and start working with R. We’ll
demonstrate some example concepts and steps, but you’ll want to follow up with
additional reading.

Section A.1 is something all readers should review as it shows where to get all of the
software support materials for this book. The other sections should be considered on an
as-needed basis as they outline the details of how R works (something the reader may
already know), and some specific applications (such as using databases) that may not be
needed by all readers. Throughout the book we have tried to avoid "just in case" teaching,
but here in the appendices we supply some things you only "might" need.

The primary tool for working our examples will be R, and possibly RStudio. But other
tools (databases, version control, compilers, and so on) are also highly recommended.
You may also need access to online documentation or other help to get all of these tools
to work in your environment. The distribution sites we list are a good place to start.

The R environment is set of tools and software that can be installed on Unix, Linux,
Apple MacOS, and Windows.

We recommend installing the latest version of R from the Comprehensive R Archive
Network (CRAN),  or mirror. CRAN is the authoritative centralhttps://cran.r-project.org
repository for R and R packages. CRAN and supported by The R Foundation and the R
Development Core Team. R itself is an official part of the Free Software Foundation's
GNU project distributed under a GPL 2 license. R is used at many large institutions
including the United States Food and Drug Administration .1

Footnote 1mSource: .https://www.r-project.org/doc/R-FDA.pdf

Starting with R and other tools

A.1 Installing the tools

A.1.1 Installing Tools

R



For this book we recommend using at least R version 3.5.0 or newer.
To work with R one needs a text editor specialized for working with non-formatted

(or not-rich) text. Such editors include Atom, Emacs, Notepad++, Pico, Programmer's
Notepad, RStudio, Sublime Text, text wrangler, vim, and many more. This are in contrast
to rich text editors (which are not appropriate for programming tasks) such as Microsoft
Word or Apple Text Edit.

When working with R we suggest considering using RStudio. RStudio is a popular cross
platform integrated development environment supplied by the company RStudio, Inc. (

). RStudio supplies a built in text editor, and convenient userhttps://www.rstudio.com
interfaces for common tasks such as installing software, rendering RMarkdown
documents, and working with source control. RStudio is not an official part of R or
CRAN, and should not be confused with R or CRAN.

An important feature of RStudio is the file browser and the "set directory"/"go to
directory" controls that are hidden in the gear icon of the file browsing pane, which we
point out in figure A.1.

File pane gear control

Figure A.1 RStudio file browsing controls

RStudio is not a requirement to use R or to work through the examples in this book.

RSTUDIO



Git is a source control or version management system that is very useful for preserving
and sharing work. To install git, please follow the appropriate instructions from 

.https://git-scm.com
Data science always involves a lot of tools and collaboration, so a willingness to try

new tools is a flexibility one needs to develop.

All of the book support materials are freely available from Github: 
. The reader should download them in theirhttps://github.com/WinVector/PDSwR2

entirety either using Git clone with the URL https://github.com/WinVector/PDSwR2.git
or by download a complete zip file by using the "Clone or Download" control in the top
right of the Github page.

Click here to download 
everything as a zip file

https://github.com/WinVector/PDSwR2
URL for “git clone” or 

RStudio New Project -> Version Control -> Git

Another way to download the book material is to use RStudio and Git. Select File ->
. That will bring up aNew Project -> Create Project from Version Control -> Git

dialogue box as shown in figure A.1 where we can fill in the git-URL and download the
book materials as a project.

GIT

THE BOOK SUPPORT MATERIALS



Github clone URL

Figure A.2 Cloning the book repository

We will refer to this directory as  throughout the book, and all files and pathsPDSwR2

we mention are either in this directory or a sub-directory.
Please be sure to look in this directory for any README or errata files.
Some features of the support directory include.

All example data used in the book.
All example code used in the book. The examples from the book are available in the
sub-directory , and also as a zip-file . In addition to thisCodeExamples CodeExamples.zip
the entire set of examples re-run and re-rendered are shared in . (AllRenderedExamples
paths relative to where you have unpacked the book directory .)PDSwR2

A great advantage of R is there is the CRAN central package repository. R has
standardized package installation through the “ ” command. Aninstall.packages()

installed package is typically not fully available for use in a project until the package is
also attached for use by the “ ” command.  A good practice is: any sort of Rlibrary() 2

script or work should attach all of the packages it intends to use as a first step. Also in
most cases scripts should  call  as this changes the R installation,not install.packages()

which should not be done without user supervision.

R PACKAGES



Footnote 2mIn R installing a package is a separate step from attaching the for use. install.packages()
makes package contents potentially available, after that  readies them for use. A handy mnemoniclibrary()

is:  sets up new appliances in your kitchen, and  turns them on. You don'tinstall.packages() library()

have to install things very often, however you often have to turn things back on.

To install the set of packages required to work all of the examples in this book first
download the book repository as described above. Then look in the first directory of top
directory of this repository: . In this directory you will find the file .PDSwR2 packages.R

You can open this file with a text editor and it should look like the following (though it
may be more up to date than what is shown here).

To install everything run every line of code in this file from R.3

Footnote 3mThe above code is in the book support directory as , which would refer to as packages.R

, and has the Github URL .PDSwR2/packages.R https://github.com/WinVector/PDSwR2

Unfortunately, there are many reasons the install can fail: incorrect copy/paste, no
internet connection, improperly configured R or RStudio, insufficient permissions to
administrator the R install, out of date version of R or RStudio, missing system
requirements, or no or incorrect C/C++/Fortran compiler. If you run into these problems
it is best to find a forum or expert to help work through these steps. Once everything is
successfully installed, R is self-contained environment where “things just work.”

Not all packages are needed for all examples, so if you have trouble with the overall
install just try to work the examples in the book. The caveat is: if you see a "

" command fail, please try an " " tolibrary(pkgname) install.packages('pkgname')

install the missing package. The above package list is just trying to get everything out of
the way in one step.

INSTALLING THE REQUIRED PACKAGES

# Please have an up to date version of R (3.5.*, or newer)
# Answer "no" to:
# Do you want to install from sources the packages which need compilation?
update.packages(ask = FALSE, checkBuilt = TRUE)

pkgs <- c(
    "arules", "bitops", "caTools", "cdata", "data.table", "DBI",
    "dbplyr", "DiagrammeR", "dplyr", "e1071", "fpc", "ggplot2",
    "glmnet", "glmnetUtils", "gridExtra", "hexbin", "kernlab",
    "igraph", "knitr", "lime", "lubridate", "magrittr", "MASS",
    "mgcv", "pander", "plotly", "pwr", "randomForest", "readr",
    "readxls", "rmarkdown", "rpart", "rpart.plot", "RPostgres",
    "rqdatatable", "rquery", "RSQLite", "scales", "sigr", "sqldf",
    "tidypredict", "text2vec", "tidyr", "vtreat", "wrapr", "WVPlots",
    "xgboost", "xts", "webshot", "zeallot", "zoo")

install.packages(
    pkgs,
    dependencies = c("Depends", "Imports", "LinkingTo"))



R's capabilities can be enhanced by use of tools such as Perl , gcc/clang, gfortran, git,4

Rcpp, Tex, pandoc, ImageMagick, and bash shell. Each of these is managed outside of R
and how to maintain them depends on your computer, operating system, and system
permissions. Unix/Linux users have the easiest time installing these tools and R is
primarily developed in an Unix environment.  RStudio will install some of the extra5

tools. MacOS users may need Apple's XCode tools and Homebrew ( ) tohttps://brew.sh
match expected open source tool chain. Windows users who wish to write package may
want to research RTools ( ).https://cran.r-project.org/bin/windows/Rtools/

Footnote 4mhttps://www.perl.org/get.html

Footnote 5m For example we share notes on rapidly configuring R and RStudio Server on an Amazon EC2
instance here: .http://www.win-vector.com/blog/2018/01/setting-up-rstudio-server-quickly-on-amazon-ec2/

Windows users my need RTools to compile packages, however this should not be
strictly necessary as most current packages are available from CRAN in a pre-compiled
form (at lest for MacOS and 64 bit Windows). MacOS users may need to install the
XCode compiler (available from Apple) to compile packages. All of these are steps you
probably want to skip until you know you need the ability to compile.

R is a broad and powerful language and analysis workbench in and of itself. But one of
its real strengths is the depth of the package system and packages supplied through
CRAN. To install a package from CRAN, just type 

. To use an installed package, type install.packages('nameofpackage')

.  Any time you type  or library(nameofpackage) 6 library('nameofpackage')

, you’re assuming you’re using a built-in package or you’rerequire('nameofpackage')

able to run  if needed. We’ll return to the packageinstall.packages('nameofpackage')

system again and again in this book. To see what packages are present in your session,
type .sessionInfo()

Footnote 6  m Actually,  also works with quotes. The unquoted form works in Rlibrary('nameofpackage')

because R has the ability to delay argument evaluation (so an undefined  doesn’t cause annameofpackage

error) as well as the ability to snoop the names of argument variables (most programming languages rely only on
references or values of arguments). Given that a data scientist has to work with many tools and languages
throughout the day, we prefer to not rely on features unique to one language unless we really need the feature. But
the “official R style” is without the quotes.

OTHER TOOLS

A.1.2 The R package system



TIP Changing your CRAN mirror
You can change your CRAN mirror at any time with the chooseCRANmirror()
command. This is handy if the mirror you’re working with is slow.

We advise installing Git version control before we show you how to use R and RStudio.
This is because without Git, or a tool like it, you’ll lose important work. Not just lose 

 work—you’ll lose important  work. A lot of data science work (especially theyour client
analysis tasks) involves trying variations and learning things. Sometimes you learn
something surprising and need to redo earlier experiments. Version control keeps earlier
versions of all of your work, so it’s exactly the right tool to recover code and settings
used in earlier experiments. Git is available in precompiled packages from 

.http://git-scm.com

RStudio supplies a text editor (for editing R scripts) and an integrated development
environment for R. Before picking up RStudio from , you should installhttp://rstudio.com
both R and Git as we described earlier.

The RStudio product you initially want is called  and is availableRStudio Desktop
precompiled for Windows, Linux, and OS X.

When first starting with RStudio we strongly recommend turning off both the
"Restore .RData into workspace at startup" and "Save workspace to .RData on exit"
features. Having these settings on (the default) makes it hard to reliably "work clean" (a
point we will discuss in section A.1. To turn off these features open the RStudio options
pane (The Global options is found by such as menus "RStudio -> Preferences", "Tools ->
Global Options", "Tools -> Options", or similar- depending on what operating system
you are using), and then alter the two settings as indicated in figure A.1.

A.1.3 Installing Git

A.1.4 Installing RStudio



Uncheck

Move to “Never”

Figure A.3 RStudio Options

A lot of the power of R comes from the deep bench of freely available online resources.
In this section, we’ll touch on a few sources of code and documentation.

R has an incredibly deep set of available libraries. Usually, R already has the package
you want; it’s just a matter of finding it. A powerful way to find R packages is using 

: .views http://cran.r-project.org/web/views/
You can also install all of the packages (with help documentation) from a view in a

single command (though be warned: this can take an hour to finish). For example, here
we’re installing a huge set of time series libraries all at once:

Once you’ve done this, you’re ready to try examples and code.

A lot of R help is available online. Some of our favorite resources include these:

—The main R site: CRAN http://cran.r-project.org
—A question-and-answer site: Stack Overflow R section

http://stackoverflow.com/questions/tagged/r
Quick-R—A great R resource: http://www.statmethods.net

A.1.5 R resources

INSTALLING R VIEWS

install.packages('ctv', repos = 'https://cran.r-project.org')
library('ctv')
# install.views('TimeSeries') # can take a LONG time

ONLINE R RESOURCES



LearnR—A translation of all the plots from Lattice: Multivariate Data Visualization with
 (by D. Sarker; Springer, 2008) into ggplot2: R (Use R!) http://learnr.wordpress.com

R-bloggers—An R blog aggregator: http://www.r-bloggers.com
RStudio community—A RStudio/"tidyverse" oriented company site: 

.https://community.rstudio.com/

R implements a dialect of a statistical programming language called . The originalS
implementation of S evolved into a commercial package called S+. So most of R’s
language design decisions are really facts about S. To avoid confusion, we’ll mostly just
say  when describing features. You might wonder what sort of command andR
programming environment S/R is. It’s a pretty powerful one, with a nice command
interpreter that we encourage you to type directly into.

SIDEBAR Work clean
In R or R studio, it is important to "work clean" that is to start with an empty
workspace and explicitly bring in the packages, code, and data you want.
This ensures you know how to get into your ready to go state (as you have to
do or write-down the steps to get there) and you aren't held hostage to state
you don't know how to restore (what we call the "no alien artifact" rule).
To work clean in R you must turn off any sort of auto-restore of the
workspace. In "base R" this is done as follows.
We discussed how to work clean with RStudio in section .1.4.

Working with R and issuing commands to R is in fact scripting or programming. We
assume you have some familiarity with scripting (perhaps using Visual Basic, Bash, Perl,
Python, Ruby, and so on) or programing (perhaps using C, C#, C++, Java, Lisp, Scheme,
and so on), or are willing to use one of our references to learn. We don’t intend to write
long programs in R, but we’ll have to show how to issue R commands. R’s programming,
though powerful, is a bit different than many of the popular programming languages, but
we feel that with a few pointers, anyone can use R. If you don’t know how to use a
command, try using the  call to get at some documentation.help()

Throughout this book, we’ll instruct you to run various commands in R. This will
almost always mean typing the text or the text following the command prompt > into the
RStudio console window, followed by pressing Return. For example, if we tell you to
type , you can type that into the console window, and when you press Enter you’ll see1/5

a result such as . The  portion of the result is just R’s way of labeling result[1] 0.2 [1]

rows (and is to be ignored), and the  is the floating point representation of one-fifth,0.2

as requested.

A.2 Starting with R



TIP Help
Always try calling  to learn about commands. For example, help()

 will bring up help about R’s  command.help('if') if

Let’s try a few commands to help you become familiar with R and its basic data
types. R commands can be terminated with a line break or a semicolon (or both), but
interactive content isn’t executed until you press Return. The following listing shows a
few experiments you should run in your copy of R.

Listing A.1 Trying a few R commands

TIP # is R's comment character
The -mark is R's comment character. It indicates that the rest of the line is#

to be ignored. We use it to include comments, as above and also to include
output in with the results.

R commands look like a typical procedural programming language. This is deceptive, as
the S language (the language R implements) was actually inspired by functional
programming and also has a lot of object-oriented features.

1
## [1] 1
1/2
## [1] 0.5
'Joe'
## [1] "Joe"
"Joe"
## [1] "Joe"
"Joe"=='Joe'
## [1] TRUE
c()
## NULL
is.null(c())
## [1] TRUE
is.null(5)
## [1] FALSE
c(1)
## [1] 1
c(1, 2)
## [1] 1 2
c("Apple", 'Orange')
## [1] "Apple"  "Orange"
length(c(1, 2))
## [1] 2
vec <- c(1, 2)
vec
## [1] 1 2

A.2.1 Primary features of R


